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View and Print Options for Reports in Excel

This work instruction will instruct you how to change the view and print options of a
report when you are viewing it in Excel.

Logging onto the Cognos system
Re-generating a report in Excel
Changing the View on Screen in Excel
Changing the Print Options in Excel
Printing One Section of a Report

o OB~ WN P

Logging off after using the Cognos reporting tool
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1 Logging onto the Cognos system

Access to Cognos reports is through your normal log on in the ResourceLink system.

1.1 Log into ResourceLink.

1.2 Click on the Reports link found in the Favourites area of the Control Panel
on the left hand side of your ResourceLink Home Page.

ol Northgatedrinso Client - Menu Browser ol x|
Session  Edit  View Help
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@Ton @Eack Fast Path |:| @ %Coda Wiew QPrinter DSessioms ﬁAuthorisanons |21l Diary xLog aff ml

A e
‘.' & Pereon ok List v Fm Resourcelink Main Menu

— Pick a menu...

Edit Favourites...
[ Reparts
m n Object

[P Al Detalls

[P Query Taal

[P Al Soreens

[P ok Pattens ] . 1 - .
3+ Hisrarchy Post to Post Diaries e Administration
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E\ Menu, Task and Screen Search ¥

Background Information

HR - Temp Bank

or pick a task

E" E-HR Yiew 5 Detail as at Year End

|j|HRPz.qG-copy HRPATL 9/2/10 : Current Menu : UQMAINMENU Printer | Mok Selected |nDD UM [MOMEMU40 By

& The following warning box will appear.

Security Alert

%]
riit |nfarmation vou exchange with this site cannot be viewed or

changed by athers. Howewer, there iz a problem with the zite's
&l
: security certificate.

Q The secunty certificate iz fram a trusted certifying authority,

a The security certificate date is wvalid.

& The name on the security certificate iz invalid or does not
match the name of the site

Do pou want to procesd?

@ Mo J I_ Yiew Certificate
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1.3 Click on Yes.

The following screen will appear.

COGNOS" 8

nd1d06 Log OFf

View Cognos content
Use Coanos Connection to access reports, analyses and other Cognos content. Information For braad distribution can be stored and accessed From shared folders and pages. Private information,
personalized contert, and Favorite reparts can b stored and accessed from personal Folders and pages.

Manage Cognos content
Use Coanos Connection b manage the Cognos content, This incldes searching content, selscting output formats, setting schedules, smaling content, and managing saved oUEpUE versions,
Cognos Connection can also be used ko define portal pages gathering related content into integrated subject areas,

Show this page in the Future

it (C) 2007 Conos Incorporated red.
Coonos and the Cognos log are trademarks of Cognos Incorporated.

1.4 This screen appears each time you log on to the Cognos reports unless you
un-tick the box labelled “Show this page in future, so it is worth un-ticking
this box the first time you ever log in to Cognos.

15 Your Operator log in will be shown at the top of the screen next to the link
that enables you to Log Off

COGNOS’ 8

nd1d06 Log Off

Yiew Cogr
Ise Cogno:

rierennaliza

1.6 To enter and view the reports, click on the Cognos Connection link under
View Cognos Content.

COGNOS' 8 ‘ H

nd1d06 Log Off Home

Yiew Cogres-centent

Ose Cognos Connection to atgess reports, analyses and other Cognos conkent, Information for broad distribution can be stored and accessed from shared folders and pages. Private information,
personalized content, and Eavorite reports can be stored and accessed From personal folders and pages.

Manage Cognos content

Use Cognos Connection ko manage the Cognos content. This includes searching content, selecting output formats, setting schedules, emailing content, and managing saved output wersions.
Cognos Connection can alsa be used to define portal pages gathering related content inta integrated subject areas.

Show this page in the Future

Copyright {C) 2007 Cognos Incorporated. All rights reserved.
Cognas and the Cognos logo are trademarks of Cognos Incorporated. THE MEKT LEVEL OF PERFORMANCE
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2 Re-generating a report in Excel

Once you have selected any report and run it, it will open in PDF format by default.

2.1 To re-generate the report in Excel, simply click on the Excel button on the
top-right of the screen (circled below).

Q@ About
= b - E =0 J=
" -
Staff list =
Post Title Post Location Career | Subproject SPC SPC | SPC | Employee Grade Grade | Current
Grade Pathway Code Description | Ees | Ers Grade Change Start Foint
a o Reason Date —
HR & GRADE Highfield MSA 504377101 HR & Payroll 100 100 GRADE 4  Annual 1 Aug
PAYROLL 4 Campus, Froject Incrermnent 2007
Southarpton
PATROLL GRADE  Highfield MZ4 504376101 Finance & 100 100 GRADE 3 Annual 1 Aug
AMND 3 Campus, Procurement Increment 2007
PENSIONS Southarmpton
HR & GRADE Highfield MSA 504377101 HR & Payroll 100 100 GRADE 4  Annual 1 Aug
PAYROLL 4 Campus, Froject Incrermnent 2007
Southarpton

2.2 After a few seconds you will be asked whether you would like to Open, Save
or Cancel the file in Excel. Click on Save:

File Download x|

Do you want to open or zave this file?

@ j Mame: ... CvEvCheGgueydMygqaEiviiMdihEgwghCedMIGs, xls
IH Type: Microsoft Excel Worksheet, 143 KB
From: uos-app00037-si

Open Save Cancel

Always ask before opening this bepe of file

harm pour computer. [F you do nob tust the source, do not open or

@ YWhile filez from the Internet can be uzeful, some filez can potentially
zave thiz file, What's the rizh?
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Specify where you would like to save the report, give the file a suitable name
and click on Save:

Save@ =) My Documents ) v| o F e o
. —— —
(CIASRP @Mv Sharing Folders

D

|5 Cuskam installs

My Fecent Iy Diata Sources
Documents My eBocks
]ﬁMy Music
@ uﬂMy Pictures
Desktop =My Received Files
15My Shapes
T EMV Yideos
L} [CyPalm 05 Deskkop
E hot
My Documents Chsereenshots
I 5naglt Catalog

[ Temp file stare

:jj}g L) Tom
! (53 Training Folder

My Computer

.

‘g File name: My example report. 2ls ) hd | [ Save
- —
tdy Metwork Save as type: Microzaft Excel Workshest W | ahice

& As these are HR reports containing sensitive data, do ensure that you
save them to a suitable location (do NOT save them to public areas
of a resource drive, for example).

If you get a pop-up window, informing you that download is complete, place
a tick in the tick-box to avoid getting this message again, and then click on
Open:

Download complete

N
Dovenload Complete

Saved:
«qaElvlirdibSgwgCydriaGE, xls From uos-app000S7-si

EEX]

(R RSN R NN R R NN RN AR RN NN A NRRNANANR RN RNNRRRARN 3
Downloaded: 143 KB in 1 sec
Download bo: \soktom,ac,ukl, My example repart, xls

fer rate: 143 KB|9ec

Clfze thiz dialog box when download completes

Cloze

2.5

[ Open

] [ Open Faolder ] [

Your report will now open in Excel.
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3 Changing the View on Screen in Excel

3.1

There are a couple of ways to zoom in or out in Excel (so that you can view

more or less data within one screen). Either go to the View menu and click
on the Zoom... line:

E3 Microsoft Excel - My example report.xls

E_"l File Edit | Wew | Insert Faormat Tools Data  Window  Help
: by [ : Al 2 i
) (5 (] noms B F9- 08 5 -8 AL G
__] o Wt R Al Page Break Preview | ¥+ Reply with Changes,.. End Review, .. !
] Task Pane ZtrH+F1
&, Toolbars C o[ E F
-

of Earmula Bar
1 E Status Bar
4 |Full Time
c [PsG Header and Footer, .,
§ [Human Re; . ™, Comments
7 |[Employee
& |Epeople T Custom Yiews. .,
9
10 | Emplayes M &l Full Seresn Forename | Title [ Gender Email Address
» | Zoom... MR M @soton.ac.uk

F MR M @soton.ac.uk
12
r MR R @zoton.ac.uk

13
14 |Organisational Development
15 |Career Pathways & Pay
16
17 | Employee Mumber | Surname | Forename | Title | Gender Email Address |

3.2

enter any percentage, then click on OK:

foom

Magnification
) z00%,
) 100%s
() 75%
() 50%
) 25%
O

3

OI"IO

][ Cancel ]

3.3

Then select one of the listed zoom percentages, or use the Custom field to

Alternatively, you can simply hold down the Ctrl key on your keyboard and

then use the scroll button on your mouse to zoom in or out.
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4 Changing the Print Options in Excel

4.1 You can use the Print Preview button to see how the report would look if
you printed it as it is:

Microsoft Excel - My example report. xls

E_] File Edit ‘ew In Format Tools Data  Window  Help
3 5.0 Ja._.-aluue DA F|9 .0 @ s AL

e It s B R | Brint F‘relx-'i;:\ll | [l | ¥4 Reply with Changes... End Review... !
Al - *
A | E | C | D | E

University .
of SD-I.lthil.mptﬂl'la ﬂ: | ISt

Full Time - Fixed Term
PSG

Human Resources
Employee Resourcing
Epeople Team

CO (00| = | | b (] —

—
]

Employee Nurnl:uer| Surname | Forename | Title |Gender

4.2 This will open the Print Preview page view:
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4.3

4.4

4.5

[Rrgen] o roch Prrvem] [ cioe ] [t |

st ISE

oBRETT R ves F
e i . F
e D E MEE
s ey W
o e o
i ST e F
M cAvesTE st
aseme s W F
I B Lol
ATIENEH e L
ke ey 3

Freview: Page 1 o 20

Simply click on the Close button to return to the normal Excel workbook

view.

When you do return to the normal Excel workbook view, you will notice that
dashed lines now appear on the screen, indicating where the page breaks
would be if you were to print off the report as it is now:

A B | € | o] E F | G | H | | J
niversity f
MSouthamptonaff IlSt
1 ) Dashed lines indicate
4 |Full Time - Fixed Term where the end of the
9 |PSG :
o e T— printable page currently
7 |Employee Resourcing lies
8 |Epeople Team
g
10 [Emplayes Number | Surname Forename [ Title [Gender Email address [ Continuous Service Date [Emp End Date [Post Start Date Post
MR M @satan.ac.uk 17 Jul 2006 23 Apr 2007 DDO3003777 {HR & |

1 ADVT

r MR M @soton.ac.uk 26 Mar z007 26 Mar 2007 RRO4003763 (PAYRC
12 ASST

r MR M @saton.ac.uk 2 Apr 2007 2 Apr 2007 DDO3003777 {HR & |
13 ADVT
14 | Organisational Development
15 |Career Pathways & Pay
16
17 |Employee Numhar’l Surname Forename ‘ Title: |Gender’ Email Address Continuous Service Date | Emp End Date |Post Start Date Post
18 MISS F @saton.ac.uk 1 Aug 2007 1 Aug 2007 DDO3004463 {CLERT
19 [Full Time - Permanent
20 |PSG
21 |Human Resources
22 |Employee Resourcing
23 |Epeople Team

To adjust the print setting, use the File menu and go down to Page Setup...:
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4.6

E3 Microsoft Excel - My example report.xls

Hl= I] File Edit Wiew Insert  Format  Tools Data  Window  Help

A ] T Chrl+M - [ . | % =
d '-j Dpen... Crl+O Changes... End Rewvie

Close
=] save Chrl+s H

17 Save fs Emp End Date |P
18 - v

19 aly Save asWebPage...

20 Save Workspace. ..

21 |en -
—— | File Search...

Al b

>3 Permission 3
A W'eb Page Preview

25 Ermp End Date |P
25 Page SetJ:...) B

2| Svmem— y B

28 ) .

5 & Print Preview

30| = Print... Ckrl+P Emp End Date |P
l Send To [

32 L

33 Properties c]

34 1 My example report,xls 3

35
E 2 T phase 1 full training schedule1148405F 109, x1s

a7 3 T phase 1 full training schedule11483ef1d68, x1s Emp End Date |P
i 4 T phase 1 full training schedule114833d169¢,xls B

39

A0 Exit h

A Page Setup window will appear, wherein you will be able to make the
following changes to your document:

Page Setup
H Margins | Header/Footer | Sheet
Orienkati
Iy
I
®porye O tantscre
(® adjustto: [100 |5 % normal size
O Fit ko pageis) wide by tall
Paper size: |.¢\4 . |
Print guality: |6DD dpi v|
First page number:
I Ok ] [ Cancel

[ ]

e Set the page to automatically fit 1 or 2
(Page tab)

[ ]

Set the page to either portrait or landscape orientation (Page tab)

or 3 etc. pages on each printed page

Set the margins around the edge of the printed page (Margins tab)
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e Add a header and/or footer to the printed page (Header/Footer tab)
e Set row and/or column headings to print on each page (Sheet tab)

e Select whether the page prints gridlines, etc. on the printout (Sheet tab)
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5 Printing One Section of a Report

If you have a large report and only wish to print off a small section of it, then
you can set up the print area by following these steps:

5.1 Use your mouse to select the area that you wish to print:

i | G | | ! [ 4 |
.ddress Continuous Service Date [Emp End Date |Post Start Date Post
1.ac.uk 3 Jul 2006 3 Jul 2006 DDO1003402 HR BUS
Tac.uk 31 ul zo0a 31 Jul 2006 | DD0O1003401 |HR BUS
\ddress Continuous Service Date [Emp End Date |Post Start Date Post
ac.uk 1 Sep 1992 & Moy 2000 DDO1003403 HR CLI
Lac.uk 15 Jun 2001 1 Aug 2003 DDO1003403 HR CLI
ac,uk 5 Sep 1953 S Sep 1983 DLO1003403 HR CLI
won.acuk 14 May 2007 14 May 2007 DDO1003776 CLIEMT
\ddress Continuous Service Date |Emp End Date Post Start Date Post
ac.ule | 1 Aug 2003 26 Mar 2007 DDO1003572 [PERSC
ac.uk 6 Jul 2004 & Jul 2004 DDO10O03408 |PERSO
ac.uk 3 Sep 2001 19 Jun 2007 DDO1003417 fSEMIOF
ac.uk 9 Oct 2006 9 Oct 2006 DOO1003405 (PERSC
Jton.ac.uk 18 Dec 2006 18 Dec 2006 DCO1003397 (HEAD |
ac.uk 11 Sep 2000 11 Sep 2000 DDO10O03572 PERSO
ac.uk 11 May 1995 11 May 1998 DDO1003408 PERSO
ac.ulk 4 May 2004 1 Mar 2006 DCO1003417 (SEMICFE
ac.uk S Sep 2005 S Sep 2005 DOO1003572 (PERSS
scubke 21 Aug 1996 17 Jun 2002 DDO1003572 PERSO
rac.uk 16 Aug 2004 16 Aug 2004 DDO1003408 PERSO
7 May 2007 7 May 2007 DOO1044022 JINTERI

5.2 Then go to the File menu and select Print Area / Select Print Area:
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5.3 The area that you have selected will now have a thicker border around it:
dress Continuous Service Date |Em|:| End Date|F'|:|st Start Date| Fost
s.uk 1 Aug 2003 26 Mar 2007 DDO1003572 [PERS:
c.uk & Jul 2004 & Jul 2004 DDO1003408 |PERS
sk 3 Sep 2001 19 Jun 2007 DDO1003417 [SEMIC
uk 9 Oct 2006 9 Oct 2006 DDO1003408 [PERS
an.ac.uk 18 Dec 2006 18 Dec 2006 DDO1003397 [HEAD
.uk 11 Sep 2000 11 Sep 2000 DDO1003572 [PER S
sk 11 May 1998 11 May 1998 DD01003408 [PER S
Uk 4 May 2004 1 Mar 2006 DDO1003417 [SEMIC
sk 5 Sep 2005 5 Sep 2005 DDO1003572 [PERS
uk 21 Aug 1926 17 Jun 2002 DDO1003572 PERS:
sc.uk 16 Aug 2004 16 Aug 2004 DDO1003408 [PER S
7 May 2007 7 May 2007 DDO1044022 [INTER
5.4 If you are happy with the selection then you can simply click on Print to print
this section.
5.5 To de-select this area, go to the File menu and then Print Area / Clear Print

Microsoft Excel - My example report.xis
5 File dit Wiew Insert Format Tools Data  Window Help
1 Mew. ., Chrl+m = = | ﬁ? = El j
. e | [
i L Open Qe Ehanges... End Review,.. H
Close
=l save Chrl+s H |
17 Save As... Ermp End Date | Post Stal
18 F 1 Au
19 | ag Save as Web Page...
20 Save Workspace, ..
21 | ex .
—— "d Filz Search...
o7 | b
23 Permission 3
A ‘Web Page Preview
25 [Erp End Date | Post Stal
26 P 3"-——_.—.__-...‘3 h
3; | ( Prink Area ) Set Print Area ?H
29 _l VIR \ Clear Print Area
30 | =4 Print... CrH-P tal
E 6 M
i Send To » o
32 L 1 Au
33 Properties B 5 S
34 1 My example repart, xls i 14 Ma
35
? 2. dphase 1 Full training schedulel 148405F1c9,xls
37 3C.dphase 1 Full training schedulel 1483eF1d68, <Is Emp End Date | Post Stal
i 4 ... dphase 1 full training schedulel 14633d169¢, xls B 26 M:
39 60
A0 Exit L 19 Ju

Area.
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6 Logging off after using the Cognos reporting tool

6.1  Click on the 229 jcon at the top of the screen.

The following screen will be displayed.

ou are logged off.

Log on again...
. . . . Log on again... |
6.2 If you want to log in again, simply click on the link.

You will then be taken back to the initial screen to enter the system.

6.3 If you have finished using Cognos, click on the white cross in the red box to
close the Cognos window.

i o s Click here to log
out of Cognos

] oo (D S Locsl wtranat
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